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RECOLHA E TRATAMENTO 

DE IMAGENS DOS SATÉLITES 

NOAA 

 

 
 
Tutorial/Atividades de Investigação 

 
3.º Ciclo, Secundário, Profissional 

 
Ciências Naturais | Física | Físico-Química | Geografia 

 

Alterações/Mudanças Climáticas, Deteção Remota, 
Meteorologia, Satélites, Sensores, Radiação. 
 

 

 

Com esta atividade conseguirá recolher e compor imagens dos satélites NOAA 15, 18 e 19 de forma totalmente gratuita. 
O recurso permite a utilização de imagens reais como fator de motivação dos alunos possibilitando o trabalho, em contexto 
real, com instrumentos desenvolvidos pela comunidade científica.  
 

 

ENQUADRAMENTO TEÓRICO 

 

A Deteção Remota consiste num conjunto de técnicas que permitem obter informações sobre um objeto, ou fenómeno 

físico, sem estar em contacto direto com ele. Um sistema de deteção remota pode envolver vários sensores. A maioria das 

aplicações que são consideradas parte da deteção remota têm que se enquadrar nos seguintes critérios: 

• A transferência de informação entre o objeto e o sensor ocorre por meio de radiação eletromagnética; 

• A observação leva à produção de uma imagem espacial; 

• As imagens terão que ser em formato digital. 

Os instrumentos utilizados em deteção remota utilizam a radiação eletromagnética, de forma passiva (caso dos 

radiómetros e espectro radiómetros) ou ativa (caso do radar). A observação remota mede as trocas de energia que 

resultam da interação entre a energia contida num determinado comprimento de onda (ou numa banda de comprimentos 

de onda) do espectro da radiação eletromagnética e os átomos ou moléculas constituintes do objeto que se pretende 

observar. A deteção remota também inclui as atividades relacionadas com a distribuição, processamento, interpretação 

das imagens e entrega do produto final. A deteção remota é utilizada, entre outras áreas, no estudo de fenómenos 

meteorológicos. Os satélites meteorológicos levam a bordo instrumentos (em geral radiómetros funcionando em 

diferentes bandas do espectro eletromagnético) projetados para monitorizar as condições de tempo. Os satélites 

meteorológicos ajudam a estudar os padrões associados às condições de tempo, em vastas áreas, e à sua previsão. 

Criada em 1970, a Administração Nacional Oceânica e Atmosférica (em inglês, National Oceanic and Atmospheric 

Administration – NOAA) é uma Agência Norte Americana responsável pela exploração operacional dos satélites 

meteorológicos e ambientais. Os satélites da série TIROS/NOAA têm a bordo, além de outros instrumentos, o radiómetro 

AVHRR (Advanced Very-Hight-Resolution Radiometer – Radiómetro Avançado de Muito Alta Resolução). 

Este tutorial explica como recolher imagens, em tempo real e de forma gratuita, captadas pelos Satélites NOAA 15, 18 e 

19, durante a sua passagem sobre território Europeu, utilizando uma antena localizada Centro de Tecnologia e Pesquisa 

Aeroespacial Europeia (European Space Research and Technology Centre – ESTEC) em Noordwijk, nos Países Baixos. Esta 

antena está ligada a um WebSDR que é um software de receção de rádio ligado à Internet, permitindo que muitos ouvintes  
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a utilizem simultaneamente. A tecnologia SDR (Software Defined Radio - Rádio Definido por Software) torna possível que 

todos os ouvintes sintonizem o recetor de forma independente e assim ouçam sinais diferentes. 

 

Área 

• Sustentabilidade na Terra (Ciências Naturais, 7.º ano) 
• Mater iais (Físico-Química, 7.º ano) 
• A Terra: Estudos e representações (Geografia, 7.º ano) 
• Meio natural (Geografia , 7.º ano) 
• Luz (Físico-Química, 8.º ano) 
• Ambiente e sociedade (Geografia, 9.º ano) 
• Energia e sua conservação (Física e Química A, 10.º ano) 
• Os recursos naturais (Geografia A, 10.º Ano) 
• Ondas e eletromagnetismo (Física e Química A, 11.º ano) 
• Módulo F3 (Física e Química, Ensino Profissional) 
• Extensão E1.FM3 (Física e Química, Ensino Profissional) 
• Módulo F5 (Física e Química, Ensino Profissional) 
• Módulo F6 (Física e Química, Ensino Profissional) 

Enquadramento 
Curricular 

Ciências Naturais, 7.º ano 
• Interpretar as principais fases dos ciclos da água, do carbono e do oxigénio, com base em 

informação diversificada e valorizando saberes de outras disciplinas. 
Físico-Química 

• Transformações físicas e químicas. 
• Ondas de Luz e sua propagação. 
• Fenómenos Óticos. 

Geografia 
• Localizar e compreender os lugares e as regiões: distinguir mapas de grande escala de mapas 

de pequena escala, quanto à dimensão e ao pormenor da área representada. Aplicar as 

Tecnologias de Informação. 
• Localizar e compreender os lugares e as regiões: distinguir clima e estado do tempo, utilizando a 

observação direta e diferentes recursos digitais (sítio do IPMA, por exemplo). 
• Localizar e compreender os lugares e as regiões: elaborar gráficos termopluviométricos, 

descrevendo o comportamento dos elementos do clima, de estações meteorológicas de 
diferentes países do Mundo. Compreender as características dos diferentes climas da superfície 
terrestre enumerando os elementos e os fatores climáticos que os distinguem. Identificar os 
fatores de risco de ocorrência de catástrofes naturais, numa determinada região. Aplicar as 
Tecnologias de Informação Geográfica, para localizar, descrever e compreender os riscos e as 
catástrofes naturais. 

Física e Química A 
• Energia, fenómenos térmicos e radiação: compreender os processos e os mecanismos de 

transferências de energia em sistemas termodinâmicos.  
• Sinais e ondas: interpretar, e caracterizar, fenómenos ondulatórios, salientando as ondas 

periódicas, distinguindo ondas transversais de longitudinais e ondas mecânicas de 
eletromagnéticas. 

• Eletromagnetismo e ondas eletromagnéticas: interpretar o papel do conhecimento sobre 
fenómenos ondulatórios no desenvolvimento de produtos tecnológicos. 

Geografia A 
• Analisar questões geograficamente relevantes do espaço português: descrever a distribuição 

geográfica e a variação anual da temperatura e da precipitação e relacioná-las com a circulação 
geral da atmosfera. Relacionar a posição geográfica dos principais portos nacionais com a 
direção dos ventos, das correntes marítimas, as características da costa e do relevo do fundo 
marinho. 

Física e Química – Ensino Profissional 
• identificar as várias etapas do conhecimento da natureza da luz e os princípios de funcionamento 

de fontes de luz comuns; relacionar os conceitos de luz e cor. 
• descrever interpretar os fenómenos da reflexão, da refração e da dispersão da luz. 
• compreender a linguagem própria da Termodinâmica e interpretar as suas Leis; interpretar 

acontecimentos do dia a dia através das Leis da Termodinâmica; perspetivar a evolução histórica 
da Termodinâmica; discutir resultados experimentais. 

• identificar as grandezas principais que descrevem as ondas sonoras; interpretar as impressões 
sonoras detetadas pela audição ou por dispositivos mecânicos ou eletrónicos como resultantes 
de vibrações de partículas, que se propagam no espaço através de ondas. 
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QUESTIONAR 

 

1- Como é que os meteorologistas conseguem ver as tempestades? 

2- É possível tirar fotos, a partir de satélites, a qualquer altura? 

3- Como é que se sabe onde estão as tempestades e para onde elas vão? 

4- Como é que os meteorologistas sabem a espessura das nuvens? 

 

 

TUTORIAL 
 

Tutorial para produzir imagens a partir do sinal rádio emitido pelos satélites NOAA 15, 18 e 19. 

O tutorial pode parecer, inicialmente, complexo (principalmente se não tiver grandes conhecimentos de informática) 

mas resume-se, depois da primeira utilização, a 4 passos simples: 

i. Informação sobre o nome, frequência de emissão, o dia e hora de passagem (software WXtoImg) 

ii. Recolha do áudio do satélite (aplicação on-line WebSDR) 

iii. Alteração na frequência da amostra (software Audacity) 

iv. Conversão do áudio recolhido e tratado (software WXtoImg) 

 

Para recolher e tratar as imagens dos satélites NOA A vai precisar de: 

o Um navegador de internet (Firefox, Chrome, Edge, Opera, etc.) com suporte HTML5; 

o Software Audacity (https://www.audacityteam.org/ ); 

o Software WXtoImg (https://wxtoimgrestored.xyz/ . Se este link não estiver funcional, procurar no 

Google pelo software WXtoImg. Se o ficheiro de instalação não correr, experimentar instalar a versão 

beta. Se o nome do utilizar do PC tiver acentos ou cedilhas, instalar o programa na raiz do disco C:. Este 

tutorial foi feito utilizando a versão 2.3.3 do software Audacity e a versão 2.11.2 beta do software 

WXtoImg, a correr no sistema operativo Windows 10;  

o Ligação à internet para acesso ao WebSDR (http://erc-websdr.esa.int/ ). 
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Configuração do WXtoImg: 

1 - Depois de instalar o programa abrir o mesmo. 
A primeira janela pede para colocar a 
identificação e local da antena. Introduzir, como 
mostra a imagem a seguir, os dados: 

City: Noordwijk 

Country: Netherlands 

Latitude: 52.24 

Longitude: 4.45 

Altitude (meters): 1.0 

 

 

 

 

 

 

 

 

 

 

 

2- Esta configuração também pode 

ser feita no separador “Options-> 

Ground Station Location” 

 

 

 

 

 

 

 

 

 

 

 



5 

 
 
 
 

 

3 – Ativar o modo “expert” no separador “Options->GUI Options”, carregar em “OK” e reiniciar o programa. 
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4 – Verificar se, no separador “Options”, estão selecionadas apenas as opções “Use other sensor”, “Show All”, “Crop 

telemetry” e “Resync”, como mostra a imagem. 

 

5 – Atualizar (regularmente, antes de realizar recolhas) a lista Keplers no separador “File->Update Keplers” 
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6 – Ver a lista das próximas passagens dos satélites, a hora (UTC) para poder determinar a sua hora local, a duração da 

visibilidade do satélite (em relação à antena) e a frequência de emissão em kHz (que deve ser colocada em Hz no WebSDR): 
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Configuração do WebSDR e recolha do sin al: 

1 – Algum tempo antes da 

passagem do satélite, abra o 

navegador e carregue a página 

http://erc-websdr.esa.int/ 

2 – Introduza, no espaço 

“Frequency”, a frequência do 

satélite (em Hz) retirada da 

informação da lista Kepler e 

selecione o modo “FM” 

 

 

 

 

 

3 – Carregando (sem largar) no 

botão esquerdo do rato, em cima 

da zona da imagem 

correspondente ao sinal ao longo 

do tempo, centre a frequência 

ajustada. 

 

 

 

 

 

 

 

 

4 – Carregue em “zoom in” ou 

“zoom out” (conforme 

necessário), centrando a 

frequência, e ajuste as abas do 

filtro (ambos os lados) 
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Até ter a informação de largura de 

banda de 30,09 kHz e 30,55 kHz 

(aproximadamente). Pode 

também ativar o “autonotch”; 

 

 

 

 

 

5 – 1 a 2 minutos antes da 

passagem do satélite inicie a 

gravação do sinal. 

 

 

 

 

 

 

6 – Durante a gravação pode ajustar um pouco as 

abas de limite do filtro, para melhorar a captura. A 

imagem mostra um exemplo do sinal do satélite que 

será acompanhado com informação áudio. 

 

 

 

 

7 – No final da passagem carregar em “Stop” (no mesmo local 

onde estava o “Start”, no “Audio recording”) e proceder ao 

dowload do ficheiro áudio (se ele não iniciar automaticamente), 

gravando-o no disco rígido do seu computador. 
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Preparação do ficheiro áudio n o Audacity: 

1 – Abrir o Audacity 

2 – Abrir o ficheiro 

áudio (retirado do 

WebSDR e guardado no 

disco rígido do seu 

computador) no 

separador “Ficheiro-

>Abrir…” 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3 – Na janela, em baixo 

e à esquerda, 

selecionar 11025 Hz 

como “Taxa do 

Projeto”. 
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4 – Selecionar “Re-amostragem…” no separador “Faixas->Re-amostragem…” 

 

Na caixa que se abre automaticamente selecionar 11025 Hz como “Nova taxa de amostragem” e carregar em OK. 
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5 – Exportar o 

ficheiro áudio no 

formato wave, no 

separador “Ficheiro-

>Exportar->Exportar 

como WAV”, 

guardando numa 

pasta distinta (para 

não perder o 

ficheiro original). 

 

 

 

 

 

 

 

 

 

 

 

 

Produção da imagem recolhida: 

1 – Voltar a abrir o WXtoImg 

2 – Abrir o ficheiro áudio tratado (e exportado como wav) no separador “File->Open Audio File…” 
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3 – Apesar do software detetar automaticamente o satélite, por vezes essa função não funciona (ou funciona mal) pelo 

que pode forçar a escolha do satélite no separador “Satélite”. 

 

4 – No separador “Enhancement” 

escolher os filtros 

(correspondente a diferentes 

comprimentos de onda) que 

queremos visualizar. Os filtros 

“HVCT false colour” e “HVC false 

colour” adicionam cores ao 

mapa, o que pode por vezes dar 

um aspeto falso, pelo que se 

aconselha a experimentar para 

ver se a imagem melhora ou não. 
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5 – Depois de escolhido o filtro, pode 

fazer alguma edição da mesma no 

separador “Image”. O ajuste “Histogram 

Equalise Image” pode ser interessante. 

Pode ainda utilizar a ferramenta “Crop 

image…” para eliminar as zonas de ruído 

na imagem (captadas antes e depois do 

satélite estar em vista, correspondentes 

à parte superior e inferior da mesma).  

 

 

 

 

 

 

 

 

6 – No final, vá ao separador “File-> Save 

Image as…” e grave no formato JPG a 

imagem que recolheu e tratou. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

7 – Por vezes não se consegue a imagem que se queria nem visualizar o que se pretende. Isto acontece por vários motivos 

(atualização dos Keplers, erros no programa WXtoImg, alteração nos nomes dos ficheiros, etc.) por isso, se não conseguiu 

à primeira tente novamente pois os satélites passam várias vezes por dia. 

8 – Existem aplicações para telemóvel e computador que mostram a posição dos satélites em tempo real. Esses softwares 

podem ser mais um fator de motivação dos alunos, que podem acompanhar o satélite nos seus telemóveis enquanto 

ouvem o sinal rádio que ele emite. A utilização destes softwares também ajuda a uma melhor compreensão da visibilidade 

do satélite relativamente a uma antena que está num outro país e à propagação de ondas eletromagnéticas em linha reta: 

se não se ouve o satélite, este está escondido pela curvatura terrestre, mesmo que já seja visível em Portugal. Pode 

encontrar aqui a lista de softwares para seguimento de satélites. 
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EXPLORAR 
 
 

1 – Instalar e verificar todo o software e verificar que está tudo funcional. 

2 – Atualizar a lista Kepler e fazer um calendário dos dias, turmas e horas em que se podem recolher os sinais rádio 

dos satélites NOAA 15, 18 e 19. 

3 – Depois de uma primeira exemplificação, permitir que os alunos façam a recolha do sinal rádio. O professor deve 

fazer uma recolha do sinal dos satélites, guardando uma cópia dos ficheiros originais num local que possa ser acedido 

por todos os alunos, registando também a qual dos satélites corresponde o ficheiro áudio. Para este efeito pode, por 

exemplo, utilizar uma pasta na nuvem dando privilégios de leitura (apenas) aos alunos e criando uma tabela de 

correspondência entre o nome do ficheiro e o satélite. As informações sobre a data e hora da recolha ficam registadas 

no nome do ficheiro, mas também podem fazer parte da lista. 

4 – Permitir que os alunos tratem o ficheiro áudio, o convertam em imagem, testem os diferentes filtros, exportem 

para JPG e a tratem a nível artístico (com o software WXtoImg ou um outro software como o Gimp). 

5 – Pedir aos alunos que apresentem à turma as suas imagens, a escolha de filtros, o que observaram, testaram, etc. 

6 – Desafiar os alunos a fazerem recolha de imagens em casa, durante a passagem de satélites em dias e horas não 

letivas. 

7 – Pedir aos alunos que façam a identificação e o seguimento de ciclones e superfícies frontais, utilizando imagens 

de passagens sequenciais de diferentes satélites. 

8 – Acompanhar eventos meteorológicos extremos, recolhendo imagens, analisando-as, cruzando esses dados com 

os avisos do IPMA e um levantamento da cobertura realizada pelos media. 

9 – Fazer uma exposição das imagens recolhidas e tratadas pelos alunos. 

10 – Procurar grupos de Rádio Amadores que ajudem à construção de antenas de receção de sinal destes satélites, 

na escola. 

11 – Visitar o IPMA e assistir ao lançamento de balões estratosféricos. 

12 – Fazer filmes de apresentação meteorológica utilizando aplicações de telemóvel e/ou informáticas de “Chroma 

Key”. 

13 – Fazer artigos de divulgação para os jornais locais ou da escola. 

14 – Convidar investigadores à escola e trocarem ideias com os alunos sobre as imagens que recolheram. 
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SABER MAIS 
 
 
 

• Satélites Meteorológicos - Área educativa do Instituto Português do Mar e da Atmosfera com a 

explicação do que é a deteção remota, funcionamento dos satélites, captação de imagem, 

radiação utilizada e interpretação das imagens. 

• O que é a deteção remota? – Página da Agencia Espacial Europeia com a explicação do que é a 

deteção remota. 

• Como funcionam os satélites? Espectrómetro de refletância – Atividade do ESERO Portugal 

(Ensino Secu8ndário) para a compreensão do espetro eletromagnético e sua utilização nos 

satélites. 

• Compreender a Terra através do Espaço: O Kit completo! – Kit de atividades ESERO Portugal. 

• Simulação de furacões e aerossóis – Recurso Vídeo com o exemplo da utilização de satélites para 

o estudo da dispersão de aerossóis. 

• Anemómetro – Atividade para a construção de Anemómetros. 

• Pluviómetro - Atividade para a construção de Pluviómetros. 

• Conversão térmica da energia solar – Atividades sobre transferências de energia na forma de 

radiação e calor. 

• Porque o céu é azul? – Recurso Vídeo sobre a Luz e as condições para a cor do céu. 

• Clima EduMedia – Página do projeto EduMedia desenvolvido pela Faculdade de Letras da 

Universidade do Porto ao abrigo do Programa “AdaPT – Adaptando Portugal às Alterações 

Climáticas”. 

• Fundamentos Teóricos de Deteção Remota – Sebenta do Departamento de Engenharia Rural da 

Universidade de Évora. 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

tipologia  nível de ensino  áreas disciplinares  áreas temáticas  duração 


